
 

 

 
�Danville Signal Processing, Inc. 

 
 
 

 
 
 

DSP-8200e 
Tone Suppression &  

Noise Reduction System 
 
 

 
 
 
 
 

 

Operating Manual 
Version 4.07 

 
 
 
 



 
 

DSP-8200e Operating Manual                                                                                          Page 2 

  

Danville Signal Processing, Inc. 
DSP-8200e Tone Suppression & Noise Reduction System 
Operating Manual 
 
Copyright © 2009-2010 Danville Signal Processing, Inc.  All rights reserved.  Printed in the USA. 
 
Under the copyright laws, this manual may not be reproduced in any form without prior written 
permission from Danville Signal Processing, Inc. 
 
Danville Signal Processing, Inc. strives to deliver the best product to our customers.  As part of 
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Digital Signal Processing 
 
Digital Signal Processing (DSP) is a powerful and complex method of analyzing and modifying 
analog signals, such as speech. Speech signals have fairly well known and predictable 
characteristics; however, these characteristics are quite complex.  
 
By converting the analog signal to a digital signal, a digital signal processor with a special program 
can analyze the characteristics of the analog signal. The digital signal processor can then modify 
the digital signal to enhance the desired characteristics and to remove undesirable characteristics 
such as noise or tones. The processed signal is converted back to an analog signal and sent on to 
a speaker or headphone. 
 

Overview 
 
Danville Signal has been delivering DSP-8200 systems for Tone Suppression since 1998. The 
DSP-8200e builds on this legacy by taking advantage of newer floating point DSP processing 
power while still utilizing Danville’s unique tone suppression algorithm. In addition to its 
automatic tone suppression capability, the DSP-8200e provides voice bandpass filtering, squelch 
(VOX) and fixed notch filters.  
 
Several enhancements have been added to the DSP-8200e from earlier DSP-8200 systems. 
 
The input circuits now include an analog soft limiter before the A/D converters. The limiter 
insures that signals well outside the normal operating levels are attenuated before overloading the 
A/D converter.  
 
The DSP-8200e also includes a very narrow fixed 1004Hz notch filter that can be placed in series 
with the automatic notch filter. It is estimated that 90% of all tone incidents are caused by test 
tones set to this frequency. Since there is very little speech energy at this frequency, the fixed 
notch has no impact on speech intelligibility.  
 
In some respects, DSP-8200 systems work “too well”. The DSP-8200e now includes a tone 
incident logging system that reports the channel, time, date, duration and frequency of a tone 
incident that may have occurred without even being noticed by air traffic controllers or support 
technicians. 
 
Reliability and fault tolerance has always been an important consideration with DSP-8200 
systems. In addition to redundant power supplies and passive relay bypasses, the DSP-8200e 
now includes a new watchdog function. The control module pings each DSP module once a 
second for health status. If a DSP module cannot respond, the control module sets an alarm 
condition. The DSP modules do not rely on the Control Module to perform their task, therefore if 
the Control Module fails, the system will continue to operate. 
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There are four configurations of the above functions available in the DSP-8200e. They include: 
 

• Automatic Tone Suppression 

• Ground to Ground tone suppression (404 Hz, 1004 Hz, tones > 2700 Hz) 
• Bandpass filtering 

• Bypass (audio loopback) 
 

• Squelch can be applied to each configuration except Bypass 
 

Automatic Tone Suppression 
 
The Automatic Tone Suppression mode of the DSP-8200e removes heterodynes (tones) caused 
during multiple aircraft-to-aircraft and multiple aircraft-to-controller communications. It also 
attenuates unwanted test tones that may be inadvertently applied to operational audio channels. 
This tone suppression wipes out potential harmful or distracting test and interference tones in less 
than 10 milliseconds.  
 
The automatic tone suppression function of the DSP-8200e operates by examining a 
characteristic of the audio signal called correlation, and dynamically filters out undesired tones 
from the signal. The degree of correlation is relative. Tones are highly correlated as compared to 
speech signals. The DSP-8200e uses this difference to separate speech from tones.  The DSP-
8200e can attenuate tones by as much as 50 dB depending on the specific characteristics of the 
incoming signal. The automatic notch filter works best on strong signals. Of course, it’s the strong 
signals that can cause hearing damage so this is a desirable attribute. The aggressiveness of the 
tone suppression algorithm has been carefully adjusted to eliminate damaging tones with a 
minimal impact on voice quality. If the algorithm was set too aggressively, vowels start looking 
like pure tones, which causes audible distortion. 
 
Since the vast majority of tone incidents are caused by 1004Hz test tones, the automatic notch 
filter mode also includes an optional fixed 1004 Hz notch filter placed after the automatic notch 
filter. This further reduces any remaining low level residual 1004 Hz signals.  

 

Ground to Ground Tone Suppression 
 
Ground-to-Ground circuits present a different challenge. In these circuits, certain signaling tones 
are acceptable (and required), therefore the automatic tone suppression algorithm will not work. 
It will suppress all the tones including the signaling tones. 
 
The Ground-to-Ground Tone Suppression mode specifically notches certain frequencies that are 
the most common test tones while passing the signaling tones. This greatly reduces the chance of 
a “tone incident” while using circuits where the automatic tone suppression algorithm cannot be 
used. 
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The most common test tones are 404 Hz, 1004 Hz, 2713 Hz, 2800 Hz and 3200 Hz. These are 
the frequencies that the Ground-to-Ground mode is designed to suppress. 
 
A brickwall bandpass filter is first created that is flat to 2600 Hz. This allows the highest signaling 
frequency (2600Hz) to be passed without attenuation. By 2700 Hz, signals are attenuated by 
50dB. This is a very sharp filter made possible by the use of digital signal processing. After the 
bandpass filter, the 404 Hz and 1004 Hz tones could still be present. 
 
The next filtering stage creates fixed notches at 404 Hz and 1004 Hz. These notches are very 
narrow and do not affect the speech or other signaling tones.  

Bandpass Filtering 
 
The DSP-8200e provides high performance bandpass filtering from 300 to 3400 Hz. 
Since the DSP-8200e is intended for voice communication systems, signals outside of the voice 
band generally contribute to noise. This mode is very useful in conjunction with the Squelch 
function as a noise reduction system.  The bandpass filter is also part of the Automatic Tone 
Suppression mode. 
 

Squelch (VOX) 
 
A squelch feature is also implemented in each mode. The DSP-8200e squelches silent channels 
(no communication in progress) so that channel noise is very low. This feature is particularly 
important when the same controller is monitoring multiple channels. 
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System Description 
 
The DSP-8200e consists of a 5-1/4 x 19 inch rack mounted card cage chassis, 12 plug-in DSP 
modules, a Control module, and two redundant Power Supply modules.  
Should the need ever arise; each DSP module is field reprogrammable using an ordinary 
notebook computer with a USB interface. 
 

Card Cage 
 
The card cage chassis is built around Euro rack standards. Access to modules and cabling is from 
the rear side of the chassis. Status LEDs are on the chassis front panel and duplicated on each 
module. 
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Control Module  
 
The control module monitors each DSP module for proper operation. Through the use of a 
computer interface, the Control Module offers several key functions for configuring, monitoring 
and upgrading the DSP-8200e.  Although DSP Modules are capable of operating autonomously, 
the Control Module handles all data communications. 
 
Operators can connect the DSP-8200e to a standard terminal program using a USB cable. All 
commands and status use standard ASCII characters. Danville’s DSP-8200e Control & Terminal 
program is the easiest way to configure and monitor the DSP-8200e. This Windows based 
program is discussed in a subsequent section of this manual. 
 

DSP Module Configuration 
 
Each DSP Module can be individually configured for input gain, output attenuation, operating 
mode and other parameters. Since many DSP-8200e systems have identical configurations, these 
parameters can also be set globally. 
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Fault Detection 
 
In the event of a DSP module failure, an audible alarm will alert the operator that a problem has 
occurred. To assist in identifying the failed module, the heartbeat indicator will blink at 2 times 
the normal rate. In addition, the BNC relay output will go into its fault position.   
 
A relay switch closure output (BNC connector) is provided which will indicate if power has been 
lost to the DSP-8200e as well as an individual module failure. This output may be configured (via 
shorting jumper) as either normally open or normally closed. 
 
DSP Modules have some capability to report faults to the Control Module. However, this is not 
always possible since the DSP Module may have failed in a way that it cannot communicate with 
the Control Module. The DSP-8200e includes a watchdog function. Each DSP Module is pinged 
every second by the Control Module. If there is a problem, including no response from the DSP 
Module, the Control Module creates a fault alert. Since it is possible to use a DSP-8200e without 
all 12 DSP Modules, individual modules can be bypassed. 
 
The Control Module also monitors each redundant Power Supply Module. Since only one Power 
Supply Module is required for operation, a Power Supply Module could be inoperable (blown 
fuse?) without impacting operation.  
 

Tone Logging 
 
The Control Module includes a real time clock for time and date stamping. When the watchdog 
function is enabled, the Control Module polls each DSP Module every second. Most of the time, 
the DSP will ACK back. When there is a tone incident in progress, this ACK changes to report the 
frequency of the tone. The Control Module uses this information to add to the Tone Incident log. 
The Tone Incident Log records the time, date, duration and frequency of the tone. Up to 495 
separate tone incidents can be saved in the Control Module. You can view the log with the DSP-
8200e Control & Terminal Program. You can export this data in CSV (text) or ODBC (Microsoft 
Excel) format. 
 

Firmware Upgrade 
 
DSP Modules can be reprogrammed with new firmware via the Control Module. This allows new 
features to be added after the system is installed. It is also possible to create new functions such 
as limiters, compressors, AGC and special filters for other applications. 
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DSP ModulesDSP ModulesDSP ModulesDSP Modules    
 
Each DSP module has signal processing for two audio channels. A 32-
bit high performance floating point DSP powers each module. The 
input and output audio interfaces are balanced 600 ohm lines with 
audio transformers. High quality 24 bit digital audio converters are used 
for the A/D and D/A conversions. An analog limiter prevents the A/D 
converters from overloading in the presence of very large input signals. 
 
Each DSP Module includes a hot swap/inrush current controller. This 
isolates each DSP Module from others in the same cardcage. Individual  
voltage regulators are used for local power supply requirements.  
 
Overload and Normal Level indicators are provided for each channel. A 
Heartbeat Status LED flashes at a one-second interval to show proper 
operation. A watchdog timer monitors circuit operation and will reset 
each the module in the event of program failure. To insure that audio is 
never interrupted, each audio channel is passively relay bypassed when 
the unit is unpowered. 
 
During a tone incident, the Overload LED is turned on and the Normal 
LED is turned off. Under normal operation, both the Overload and 
Normal LEDs are ON when the incoming signal level is too high. 
 
Connections are brought out to standard RJ45 jacks. Standard 
prefabricated Ethernet cables may be used for interconnects. 

Power Supply Modules 
 
Each card cage has two power supply modules for redundant operation. 
Each power supply module is fully capable of supplying all of the necessary power to operate all 
the modules. If one of the Power Supply Modules fails, the card cage will continue to operate.   
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Cable Connections & DSP 8200e Configuration 
 
 

8312 4 567

 
 

DSP Module Configuration 
 
DSP Modules can be configured for a variety of operating and test modes. Each module has its 
own dedicated DSP and flash memory. This insures that each DSP Module can operate 
independently in the cardcage.  
 
The DSP firmware resides in the local flash. This includes the operating program as well as the 
configuration settings. Each DSP Module communicates to the outside world via the Control 
Module. In turn, the Control Module connects to a Windows based PC computer via USB. This 
connection allows the DSP firmware to be updated and each DSP Module to be configured. 
 
Once a DSP Module is configured, it does not rely on the Control Module for normal operation. 
This insures that the Control Module does not create a single point of failure from an operational 
standpoint. 
 
There are two operating modes and two test modes as follows: 
 

• Automatic Tone Suppression 

• Ground-to-Ground Tone Suppression  
 

• Bandpass 
• Talkthru 

 
Any of these modes can be relay bypassed. In this case, the signals are looped via relay switch 
closures and possibly a resistive attenuator as determined by jumpers on JH3 (channel A) & JH5 
(channel B). 
 
Input and output levels are set in 1dB steps for each channel. In most cases, the factory default of 
–8dBm will be the preferred choice.  Input and outputs circuits are balanced using 600/600 ohm 
transformers for isolation. 
 

RJ-45 Connector 
 
Audio In  -  Pin 1 & 2 (600 Ohm Balanced) 
Audio Out  -  Pin 3 & 6 (600 Ohm Balanced) 
Ground  -  Pin 8 
Reserved - Pins 4,5,7 (leave open) 

 
Note: These connections are the same as 

Ethernet 10BaseT; off-the-shelf Cat 5 
cables may be used. 
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Jumper Configuration: 
 
There are six (0.100”) dual row headers on the DSP Module. Standard shorting jumpers are 
added to modify the configuration.  JH1 is a factory test connection (JTAG) and should be left 
unconnected. The remaining headers are discussed as follows: 
 

Input Attenuators JH2 & JH4Input Attenuators JH2 & JH4Input Attenuators JH2 & JH4Input Attenuators JH2 & JH4    
 
JH2 (channel A) and JH4 (channel B) allow the input to be attenuated by 12dB before the input 
A/D converters. In tone suppression applications, these jumpers should be left open. The primary 
reason for the additional attenuation would be for other applications where a very hot signal 
needs to be converted to a more typical line level. 
 

Input Load and Bypass JH3 & JH5Input Load and Bypass JH3 & JH5Input Load and Bypass JH3 & JH5Input Load and Bypass JH3 & JH5    
 
JH3 (channel A) and JH5 (channel B) configure the input impedance to 600 ohms and can 
optionally add attenuation when a circuit is passively bypassed. 
 
In most cases, jumpers should be placed across the pins 1&2 (600 ohm), and pins 3&4, 5&6 for 
unity gain bypass.  
 
If you have an application where the operating levels are set so that the output level is attenuated 
from the input, then you should remove jumpers from pins 3&4 and 5&6 and in turn place a 
jumper across pins 7&8. This causes trimpots, RV1 (channel A) and RV2 (channel B) to be 
inserted into the circuit. You can then adjust the desired amount of attenuation. 
 
Pins 9&10 are ground connections and generally ignored. 
 

Watchdog Enable JH6Watchdog Enable JH6Watchdog Enable JH6Watchdog Enable JH6    
 
JH6 enables the local watchdog timer on the DSP Module. The normal (active) condition is to 
have a shorting jumper across these pins. The watchdog reset timer should not be confused with 
the Control Module watchdog function. The local watchdog timer resets the local DSP in the 
event that the DSP fails to execute its instructions correctly. The Control Module watchdog 
query’s each DSP Module via a communications “ping” and creates an alarm condition if a DSP 
Module cannot respond. 
 

Software Configuration: 
 
The remaining settings are set via software commands. These are performed by a series of ASCII 
commands using plain text messaging. It is possible to configure the DSP-8200e using a terminal 
program, but the preferred and easiest method is with the DSP-8200e Control & Terminal 
Program. The main screen (configuration) is illustrated on the next page. 
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Modules can be set up globally or individually. If you want to set up all modules globally, you 
click on the Control Module in the DSP-8200e graphic. This will cause all the modules to change 
to blue. If all modules are set to the same parameters, then the selections will also be highlighted. 
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Parameters such as Enable Alarm and Enable Fault Relay are not specific to individual modules. 
These are grayed out when a single DSP Module is selected and can be modified when global 
configuration (click on Control Module) is selected. 
 
The picture illustrates a single module configuration, in this case, DSP Module 6. This was 
selected by clicking directly on Module 6 in the DSP-8200e graphic. The input and output levels 
are both set to –8dBm. Tone Suppression with the 1004Hz fixed notch filter and squelch are all 
selected. 
 
You can change any of these parameters by clicking on an alternate setting. You will see the 
actual ASCII commands in the terminal window in the bottom window.  
 

Level Settings: 
 
Input and output levels are set in 1dB increments. If both the input level and out level are set to 
the same values, then overall gain will be unity. It is important to set the levels to the normal 
operating level of the circuit. Generally this will be –8dBm. 
 
The input level adjustment is used to optimize the performance of the signal processing 
algorithms and to maximize signal to noise without overload. The squelch threshold is 
approximately 24dB below the nominal input level. 
 
When the DSP-8200e is properly configured, the yellow (normal) led will be on and the red 
(overload) led will flash occasionally. 
 

Operating Mode Tone Suppression: 
 
Select this mode for Air-to-Ground communications. We suggest that the 1004Hz fixed notch 
and squelch are also selected. 
 

 

WARNING: 
 

DO NOT USE TONE SUPPRESSION FOR GUARD 
FREQUENCIES 121.5 MHz AND 243.0 MHz. YOU CAN USE 

BANDPASS MODE FOR THESE FREQUENCIES. 
 

 

Operating Mode Ground to Ground Tone Suppression: 
 
This mode will suppress the most probable test tones (404Hz, 1004Hz, etc) while passing 
signaling tones that are required for mode of communications. This mode was discussed in the 
Overview section of this manual.  
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Test Mode Bandpass: 
 
The Bandpass (300-3400Hz) mode is useful for verifying the DSP-8200e DSP circuits. It is very 
difficult to characterize the performance of the audio signal chain when the tone suppression 
algorithms routinely suppress test generator tones. From a strictly hardware perspective, the test 
modes are the same as the operating modes. The difference is entirely a function of the DSP 
software. 
 
You can certainly use this mode as an operating mode to attenuate out of band noise and to 
adjust input to output levels. The fixed 1004Hz notch and squelch functions are also available in 
this mode. 
 

Test Mode Talkthru: 
 
The Talkthru mode is identical to the Bandpass mode with the exception of the 300-3400Hz 
bandpass filter. Note that Talkthru processes the audio thru the whole circuit chain as opposed to 
the Bypass function. 

Control Module Jumper Configuration 
 
A 3-pin header (JH2) configures the fault relay switch closure. This header is located near the 
front panel just behind the BNC connector. 
 
If a system failure occurs, the switch closure is open when the shorting jumper is in the NC 
position. If a system failure occurs, the switch closure is closed when the shorting jumper is in the 
NO position. 
 
The factory default position is NC (closed during normal operation and open during a failure). 
 

Control Module USB 
 
The Control Module may be connected to a Windows based PC computer via USB. A standard 
USB cable with a B connector on the Control Module side is used for a USB connection. 
 
Danville has device drivers that work with the DSP-8200e program as well as drivers that emulate 
a standard RS-232 comport. The comport driver can be used with standard ASCII terminal 
programs.  
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Watchdog Mode & System Monitoring 
 

Watchdog Ping 
 
The Control Module monitors fault conditions of the DSP-8200e. The most useful of these 
functions is the Watchdog Mode. When Watchdog is enabled, each DSP Module is pinged once 
a second. The DSP-8200e Control & Terminal Program is used to configure and monitor this 
mode. 
 

 
 
Normally, the DSP Module will respond to ping with an ACK. This means that everything is OK. If 
a tone incident is occurring, then the ACK response is replaced with a response that reports the 
frequency of tone. If the DSP Module is unable to respond, then the Control Module starts a fault 
event.  
 

Enabling the Watchdog Mode 
 
Watchdog mode is initiated by checking the Enable Watchdog checkbox in the Watchdog 
Window. Since a cardcage can be configured without a complete set of DSP Modules, it is also 
necessary to check each module position that will be expected to respond.  
 
The ping count in seconds is displayed for each module. The fault detector compares these 
numbers to the overall system total. In the example display, this was 10739. If a DSP Module fails 
to respond to a ping, then its count will be lower than the total. This is one way to see which DSP 
Module has created the watchdog fault condition. Chances are the heartbeat LED on the non-
responsive DSP Module has also stopped as well. 
 
Any time that you make a change to the watchdog configuration or after a fault has been cleared, 
you must reset the counters so that all ping counts are all realigned. 
 
When the DSP-8200e Control & Terminal program is active, the Watchdog is suspended 
regardless of the setting of the Enable Watchdog checkbox. This is due to the condition that the 
system is in a configuration mode. Watchdog will commerce automatically when the DSP-8200e 
Control & Terminal program is exited. You can temporarily initiate watchdog pings by selecting 
Start. When you select Stop, the counters will be updated. 

 
Power Supply Monitoring 
 
DSP-8200e Power Supply Modules are unregulated bipolar supplies. Series connected relays are 
used to notify the Control Module if either half of the bipolar supply has failed. This method 
works well because both relays must be energized for normal operation. If the Power Supply 
Module loses power, the relays automatically signal a fault condition. Since a DSP-8200e can 
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operate entirely with only one of its Power Supply Modules, a non-functioning Power Supply 
does not stop the DSP-8200e system.    
 

Visual, Audible and External Fault Indicators 
 
LEDs are located on each module and are duplicated the DSP-8200e Cardcage. Under normal 
operation, the Power Supply LEDs will be solidly on, and the Heartbeat LEDs on the Control 
Module and DSP Modules will be blinking at amount a 1 second interval.  
 
Under a fault condition, the Control Module has a DSP and power supply fault LEDs. These LEDs 
indicate which type of fault has occurred. The Heartbeat LED on the Control Module will also 
blink at a faster rate. 
 
Assuming that the audible alarms are enabled, then the Control Module beeper will sound 
continuously until the fault condition is resolved.   
 
The Control Module also includes a fault relay that provides either a switch closure or a switch 
open under a fault condition. The switch contacts are brought out to a BNC connector on the 
front panel of the Control Module. This allows a completely independent monitoring system to 
remotely monitor the overall operation of the DSP-8200e including the case where power is not 
available to the DSP-8200e system. If a DSP-8200e system is unpowered, all audio inputs and 
outputs are passively bypassed so that communications are not interrupted (of course, without 
tone suppression). 
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Tone Incident Logging 
 
Tone Incidents are automatically logged into the Control Module. Although the DSP-8200e 
system suppresses any tone(s) in the voice band, the logging system only recognizes five specific 
tone frequencies (404Hz, 440Hz, 1000Hz, 1004Hz, and 1008Hz). This set represents the most 
probable test tones that are likely to occur in practice.  
 
Tone Incident logging will only occur when the system has the Watchdog Mode enabled. The 
Control Module beeper will pulse on and off every second during a tone incident. 
 
The 440Hz tone may seem a bit odd, it is one of the two components in a telco dial tone. If 
multiple tones occur at the same time, this could mean that the frequency of the tone is not 
exact, for example a 1002Hz tone would likely be reported as multiple 1000Hz & 1004Hz.  
 
Up to 490 separate tone incidents are stored at one time. If this number is exceeded, the oldest 
tone incidents are dropped. You can export the log to an external file in either CSV (text) or 
ODBC (Microsoft Excel) format. 

 
**** This log is a simulation of multiple tone incidents within a very short time span.  
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Troubleshooting & Checkout 

DSP Modules 
 
The DSP-8200e signal processing modules require no adjustments or calibration. All signal 
processing functions are performed within the DSP processor. 
 
The tone suppression and noise reduction modes of the DSP-8200e do not easily lend 
themselves to traditional measurement techniques. These algorithms have been designed for 
human speech and interfering noise or tones. As such, these algorithms modify themselves 
dynamically with changing speech or noise conditions. 
 
The easiest method to verify correct operation of a DSP-8200e module is to reconfigure the 
mode to bandpass. Since all signal processing functions are performed exclusively by 
mathematical calculation, a DSP-8200e module that passes this test will also operate correctly in 
the other operating modes. 
 
 

 

WARNING: 
 

THIS PROCEDURE SHOULD NEVER BE PERFORMED IN AN  
OPERATING COMMUNICATION CHANNEL!  

 
IT IS INTENDED FOR OUT-OF-CIRCUIT TESTING ONLY. 

 
TEST TONES WILL PASS THROUGH THE DSP  

MODULE IN THIS TEST!! 
 

 
 

Test Procedure – DSP Module 
 
1.  Remove the DSP module from the card cage and reconfigure the mode to bandpass. 
 
2.  Reinstall the DSP module in an off-line, unpowered DSP-8200e card cage. 
 
3.  Apply a signal to the input of each DSP channel. The signal should be passively bypassed by 

a mechanical relay and therefore identical at the output of each channel. If this test fails, it is 
an indication of a bad relay on the DSP module or a connector/cabling problem. 
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4.  Apply power to the DSP-8200e card cage. The normal and overload LEDs will flash 
alternately during the power up stage and the heartbeat will begin the pulse at a one-second 
rate. The DSP card cage control module alarm will go off. 

 
5.  Apply a 1000 Hz sine wave to each input and adjust the level so that the yellow (normal) led 

is on and the red (overload) led is off. The output will be slightly higher than the input when 
loaded into 600 ohms. 

 
6.  Vary the input frequency from 100 Hz to 5000 Hz. The signal will attenuate outside of a 

300-3400 Hz bandwidth. If it does not, it indicates that the signal is being bypassed by the 
relay. An open transistor or defective relay could cause this symptom. 
 

 
7.  If the DSP module passes these tests, reconfigure the mode to the desired operating 

configuration.  
  

Power Supply Modules 
 
Each power supply module consists of an unregulated linear supply. Diode rectifiers on the back 
plane of the card cage isolate each power supply module from the other. 
 

Test Procedure – Power Supply 
 
1. Remove the power supply module from the card cage.  
 
2. Apply power via the IEC power connector. Remember 110 Volt or 230 Volt AC is present on 

the circuit traces. 
 
3. Verify that the green led is lit. If the led is off, check the 1 Amp fuse. 
 
4.  Typical output voltages (unloaded). 
 
 Row  (pins a,b,c of DIN connector) 
 7,8 GND 
 11  +13.7 Vdc (Analog) 
 12  -13.7 Vdc (Analog) 
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DSPDSPDSPDSP----8200e Firmware Updates 8200e Firmware Updates 8200e Firmware Updates 8200e Firmware Updates     

Overview 
 
DSP Modules and the Control Module have independent flash memory. The Control Module via 
its USB interface acts as the conduit to program the DSP Modules. Currently the firmware version 
is 4.06 for both the Control Module and the DSP Modules. You can determine the current 
firmware version from the Help menu in the DSP-8200e Control & Terminal Program.  
 
The following instructions are valid for current firmware updates. You should check any 
readme.txt instructions when updating to a newer version than 4.06, since it is possible that 
something could change. 

Control Module 
 
The Control Module firmware can be updated from a standard ASCII terminal program using 
COM port emulation. Instructions will be provided should an update ever be needed. 
 
The basic procedure is as follows: 
 

1. Connect to a terminal program. A suitable freeware program is Tera Term.  
2. Connect using RS-232 emulation. You may have to check Control Panel – System – 

Hardware – Device Manager – Ports to determine which com port is assigned to the 
USB. 

3. Press <ESC> to go to “Command Mode” 
4. At the prompt, type UF + <Enter> 
5. You have about 5 seconds to press any key <Enter> 
6. At the CM prompt, type U + <Enter> 
7. Type Y to confirm. 
8. You can now send a binary file, currently “dsp8200e_cm_v_4_06.ldr” IT IS VERY 

IMPORTANT THAT THE TERMINAL IS SET FOR BINARY FILE TRANSFER. This is a 
check box in Tera Term (File > Send File) 

9. Type in the Version String, currently “DSP-8200e CM v4.06” 
10. Press Q to run the restart. 

 

DSP Modules 
 
DSP Modules are easily updated directly from the DSP-8200e Control & Terminal Program. You 
can choose to update an individual module or all the DSP modules in the same cage. When a 
DSP Module is being updated, the DSP Module(s) will be placed in bypass. This will cause the 
module to pass audio without tone suppression, but will not otherwise disrupt communications. 
You may hear a small pop during switching.  
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The basic procedure is as follows: 
 

1. Start the DSP-8200e Control & Terminal Program. Wait for the scan to finish. 
2. Select the desired DSP Module by clicking on the DSP-8200e picture. If you click on 

the Control Module, then all DSP Modules will be programmed at the same time. 
3. Edit > Update Firmware. Follow the steps in the program. 
4. Rescan the Modules, Devices > Rescan 
5. Verify the version, Help > Firmware Versions 

 
Depending on the nature of the upgrade, the DSP Module may be reset to factory defaults. You 
may need to reconfigure the DSP Module configuration after a firmware update for the correct 
operation. 
 

Clearing Tone Logging Clearing Tone Logging Clearing Tone Logging Clearing Tone Logging     
 
The Tone Incident Log can only be cleared manually. This is to prevent unintended erasure of 
the log from an all to convenient GUI menu choice. 
 
The basic procedure is as follows: 
 

1. Type WFC 0 in the Transmit field (located above the DSP-8200e graphic) 
2. Type WFP 0 in the Transmit field 
3. Verify RFL, It should say “no file entries”. 
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Product WarrantyProduct WarrantyProduct WarrantyProduct Warranty    
 
Danville Signal Processing, Inc. products carry the following warranty: 
 
Danville Signal Processing products are warranted against defects in materials and workmanship. 
If Danville Signal Processing receives notice of such defects during the warranty period, Danville 
Signal Processing shall, at its option, either repair or replace hardware products, which prove to 
be defective. 
 
Danville Signal Processing software and firmware products, which are designated by Danville 
Signal Processing for use with our hardware products, are warranted not to fail to execute their 
programming instructions due to defects in materials and workmanship. If Danville Signal 
Processing receives notice of such defects during the warranty period, Danville Signal Processing 
shall, at its option, either repair or replace software media or firmware, which do not execute 
their programming instructions due to such defects. Danville Signal Processing does not warrant 
that operation of the software, firmware, or hardware shall be uninterrupted or error free. 
 
The warranty period for each product is one year from date of installation. 
 
Limitation of Warranty:  
 
The forgoing warranty shall not apply to defects resulting from: 
 

• Improper or inadequate maintenance by the Buyer; 
• Buyer-supplied software or interfacing; 

• Unauthorized modification or misuse; 

• Operation outside the environmental specification of the product; 

• Improper site preparation and maintenance. 
 
Exclusive Remedies: 
 
The remedies provided herein are the Buyer’s sole and exclusive remedies. In no event shall 
Danville Signal Processing, Inc. be liable for direct, indirect, special, incidental or consequential 
damages (including loss of profits) whether based on contract, tort, or any other legal theory. 
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Appendix A 
 
Typical FAA Installation: 
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POSITION

POSITION

REMOTE SITE

REMOTE SITE
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X

X
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8200e

X

X

DSP-

8200e

X

X

DSP-

8200e  
 
The DSP-8200e is useful in many FAA applications. Each module can be configured for tone 
suppression or broadband noise reduction. 
 
Tone suppression prevents loud signaling tones from reaching air traffic controllers and eliminates 
or reduces naturally occurring heterodynes between air traffic control and multiple airplanes. 
 
Noise reduction is useful in applications where channel signal to noise is poor and may be used 
to enhance intelligibility and reduce listener fatigue. 
 
The DSP-8200e is installed prior to controller switching equipment in the receive audio chain 
and does not require any FAA equipment modification. 
 
Application sites may include FAA Control Centers, Automated Flight Service Stations, TRACONs, 
Control Towers, and Flight Service Stations. 
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Specifications 
 

DSP-8200e System 
 
Channel Count :  24 channels, 2 per DSP Module 
 
System Components:  Two Power Supply Modules 
    Control Module 
    12 DSP Modules 
 
Size:    3U Cardcage (5.25” x 19” x 10”) 
 
 

Control Module 
 
External Interface:  USB 2.0 operating at full speed 
    Microsoft Windows Device Driver support (Virtual COM port) 
  
Fault Relay:   BNC, NC or NO switch closures 
LEDs:    TX, RX, DSP Fault, Power Supply Fault, Heartbeat 
 

DSP Modules 
 
Input Impedance:  600 Ohms Balanced (transformer isolation) 
Output Impedance:  600 Ohms Balanced (transformer isolation)  
Digital Signal Processor: 32-bit Floating Point DSP operating at 750 MFLOPs peak. 
Data Converter   24-bit multi-bit sigma delta with analog limiter before ADC 
Input Range (average level) 0 to –20dBm, adjustable in 1dB steps    
Output Range (average level) 0 to –20dBm, adjustable in 1dB steps 
Connector:   RJ-45 
LEDs:    Overload & Normal Level Indicators, Heartbeat 
 

Tone Notching Algorithm 
 
Type:    DSP Adaptive Filter, Proprietary & Unique by Danville Signal  
Tone Suppression  up to 50dB 
Latency:   less than 10msec 
 

Power Supply 
 
Bipolar    Unregulated, +/- 13.7V unloaded  
Power Requirements: 115VAC, 50-60Hz, 50W, may also be configured for 240VAC 

operation 
Connector   IEC Power Entry 
LED:    Power On 


